
 
 
 

PowerPoint 2003: Basics  
Learning guide 
 
 
 What’s a PowerPoint slide? 

 

 
 
 
PowerPoint presentations are composed of slides, just like 
conventional presentations.  Like a 35mm film-based slide, each 
PowerPoint slide presents one full screen of information to 
audience members, meeting attendees, or course participants.  
Unlike 35mm slides, however, PowerPoint slides: 
• are easily editable 
• can incorporate text and images from other documents 
• can utilize animation effects 
• can be easily stored, shared, and reused. 
 
PowerPoint slides can be displayed directly from your computer, 
or they can be printed to more conventional media.  Using your 
regular printer, you can print full-page PowerPoint slides or 
multiple miniature slides on each page.  Slides can also be shared 
on the web, or printed to overhead transparencies or 35mm film. 
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Launching PowerPoint 
• From the Start menu, select the All Programs submenu and 

choose New Office Document. 
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•  From the New Office Document window, click on the tab 
labeled General. 

• Double click on the Blank Presentation icon. 
 

       
 
 
 
The PowerPoint window
PowerPoint 2003 allows you to compose and edit your slides, 
navigate through your presentation, and draft your speaker notes 
without changing views or opening additional windows. 
 

 

Slide  
pane 
 
 
Task Pane 
 
 
 
 
 
Notes  
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Slides tab 

 3  



 
• The slides tab allows you to view miniature versions (called 

thumbnails) of the slides you’ve already created in your 
presentation.  Each slide is numbered in the order that they 
appear in the presentation. 

• The slide pane is the area in which slides can be created and 
existing slides can be edited. 

• The notes pane allows you to enter speaker notes that 
complement the content on each slide.  These notes do not 
appear on the screen when the slides are shown in full-screen 
mode.  However, you can print them along with your slides to 
create a set of notes pages to which you can refer during your 
presentation. 

• The task pane allows you to use PowerPoint’s layout and 
design tools. 

 
 
PowerPoint’s toolbars 
When you launch PowerPoint, two toolbars will usually appear: 
 

 
The standard toolbar provides commands for opening, saving, 
and printing presentations as well as commands for changing the 
display of your presentation. 
 

 
The formatting toolbar provides commands for formatting text 
and changing text alignment.   

 4  



Developing a new presentation 
 
Creating a new presentation using Design Templates 
PowerPoint includes an extensive selection of design templates, 
each of which includes background graphics, custom slide layouts, 
and font formatting for various types of slides.  These templates 
make it simple to quickly create and use a new presentation.  To 
add a design template to your presentation: 
• From the File menu, choose New. 
• PowerPoint’s task pane will appear, and you’ll see its New 

Presentation view. 
• In the area labeled New, click on the blue text labeled From 

Design Template. 
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• In the task pane’s Slide Design view, PowerPoint will display 
a series of slide design templates.  

• Each template will appear as a thumbnail in the task pane’s 
Apply a design template area. 

• To view the templates, use the scroll bar at the right of the task 
pane. 

• When you have selected a template for use, click once on its 
thumbnail. 

• The design you chose will be applied to each slide in your 
presentation.   
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Changing a slide layout  
After you have selected a design template for your presentation, 
use PowerPoint’s slide layouts to create new slides to hold the 
content for your presentation. 
 
Tip: PowerPoint will automatically use the Title Slide layout for 
the first slide in your presentation.  Use this technique if you wish 
to change the layout of this initial slide. 
 
• Click on the down-facing arrow at the top of the task pane. 
• From the task pane menu select Slide Layout. 
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• The Slide Layout view will appear in the task pane. 
• To display thumbnails of the available slide layouts, use the 

scroll bar at the right of the Apply slide layout area. 
• Choose the slide layout that’s most appropriate for the content 

you plan to place on your new slide. 
• Once you’ve chosen a slide layout, click on its thumbnail to 

apply that layout to your new slide. 
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Inserting text on a new slide 
Once you’ve selected a layout for your slide, you can start adding 
content to the slide.  Many of the slide layouts provide text and 
image boxes to make this process simpler. 
 
• To insert text into an existing text box, click in the box so that 

the flashing vertical insertion point cursor can be seen. 
• Once you can see the insertion point, you can enter, edit, and 

delete text within the box is as if the box were a Word 
document. 

• When you have finished composing text, click anywhere 
outside the text box to deselect it. 
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Creating additional slides 
PowerPoint allows you to add additional slides directly from the 
task pane’s Slide Layout view.   
• From the Slide Layout view, locate the thumbnail for the slide 

layout that you wish to use for the new slide in your 
presentation.   

• Place your cursor over the layout’s thumbnail.   
• Click on the down-facing arrow that appears at the right of the 

thumbnail. 
• From the drop-down menu that appears, select Insert New 

Slide. 
 

 
 
Tip: Your new slide will be inserted after the slide that is currently 
displaying in the slide pane.   
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Designing & Customizing Slides 
Although PowerPoint’s templates and slide layouts are powerful 
tools for creating effective presentations, PowerPoint also allows 
you to customize the content on each slide. 
 
Selecting text in a text box 
Before you can format the text inside a text box, you must select 
the box and its contents. 
• Click on any of the text within your text box.   
• The box’s hatched gray border and circular white handles will 

become visible around the text. 
• To select some of the text in your box, drag the cursor to 

highlight the text you wish to format. 
• To select all of the text, click on the box’s grey hatched border.  

The hatched border will become a grey dotted border, 
indicating that you have successfully selected the entire 
contents of the text box. 

 

    
Hatched border   Dotted Border 

 
 
Formatting text in a text box 
Once you have selected the text that you wish to format: 
• From PowerPoint’s Formatting toolbar click on one or more 

of the following menus or buttons.  
 

If you want to… Click on… 

Change the font of the selected text  
Change the size of the selected text  
Bold the selected text  
Italicize the selected text  
Underline the selected text  
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Aligning text in a text box 
Once you have selected the text that you wish to align: 
• From the formatting toolbar click on one or more of the 

buttons below. Only the text inside the text box will be affected 
by using one of the following buttons.  

 
If you want to… Click on …  

Align selected text on the left  
Center the selected text  
Align selected text on the right  

 
 
Creating a new text box 
Adding a new text box to a slide allows you to place text on the 
slide that might not fit into an existing text box or that might look 
best in a special position on the slide.  To create a new text box: 
• On the Drawing toolbar at the bottom of the PowerPoint 

window, click on the Text Box button.   
 

 
 
• Move your cursor to the location on your slide where you wish 

to place the new text box. 
• Click your mouse to create a one-line text box. 
• Enter your new text in the box.  Notice that the box will expand 

to fit the text that you type. 
• When you have finished entering text into the new box, click 

anywhere else on the slide to deselect the box you just created. 
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Moving a text box to a new location 
• Click on the text box you wish to move. 
• Place your cursor over the hatched border of the box so that the 

four-arrow cursor appears. 
• Drag the box to its new location on your slide. 
 

      
 
 
Resizing a text box 
• Click on the text box you wish to resize. 
• Place your cursor over one of the circular white handles so that 

a double-arrow cursor is displayed. 
• Drag on the handle to resize the text box.   
 

      
 
Tip:  Because the amount of text that will fit on each line 
determines how the text in your box will appear, any changes you 
make to the size of your box will cause the text within it to be 
rearranged. 
 
 
Rotating text boxes 
• Click on the text box you wish to rotate. 
• Place your cursor over the green circle above the image so that 

the circular-arrow cursor is displayed. 
• While holding down the left mouse button, drag your mouse to 

rotate the text box to its new position. 

       
 
 
Deleting a text box 
• Click on the text box you wish to delete. 
• Click on the box’s hatched border to ensure that the box itself 

is selected, not any text inside it. 
• On your keyboard, press the delete key. 
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Inserting saved images 
Very often, you’ll acquire images from the web or other places for 
inclusion in your PowerPoint slides.  To insert an image from your 
hard drive or a network drive: 
• In the PowerPoint window’s slide pane, display the slide on 

which you wish to insert the image. 
• From the Insert menu, choose Picture, and then select From 

File. 
 

 
 
• Use the Insert Picture window to navigate to the folder or 

drive in which your image file is saved. 
• Click on your image file to select it, and click Insert.   
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• PowerPoint will then insert the image onto your slide. 
• On some slide layouts, the image will appear in a box at the 

center of the slide.  You’ll then be able to easily move the 
image to a different location on your slide. 

• On other layouts, PowerPoint will use an existing text or image 
box as the destination for your image.  Sometimes, this choice 
will even cause your image to be resized or distorted.  To force 
PowerPoint to place the image in the center of the slide: 

o Click on the smart tag labeled with a lightning bolt that 
appears next to the image. 

o From the drop-down menu that appears, select Stop 
Automatic Layout of Inserted Objects. 

o PowerPoint will return the image to the center of the 
slide.  

 
 

Tip: Preventing automatic layout of future images 
These steps will only affect the current image you are inserting.  
To permanently turn off Automatic Layout.  
• From the Tools menu, select AutoCorrect Options. 
• At the top of the AutoCorrect window, click the tab labeled 

AutoFormat As You Type. 
• Uncheck the box labeled Automatic layout for inserted 

objects. 
• Click OK. 
 

       

Smart tag
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Moving an image 
• Click on the image you wish to move. 
• Place your cursor over the image so that the four-arrow 

cursor appears. 
• Drag the image to its new location on your slide. 
 
 
Resizing an image 
• Click on the image you wish to resize. 
• Place your cursor over one of the circular white handles on the 

edge of the image so that the double-arrow cursor appears. 
• Drag on one of these handles to resize the image.   
 
Tips: 
• The quality of your resized image will be reduced if you make it 

too large or too small.   
• When you resize an image, use the corner handles so that the 

image retains its proportions and does not appear distorted. 
 
 
Rotating an image 
• Click on the image you wish to rotate. 
• Place your cursor over the green circle above the image so that 

the circular-arrow cursor appears. 
• While holding down the left mouse button, move to rotate the 

image to the desired position. 
 
 
Deleting an image 
• Click on the image you wish to delete. 
• Press the delete key on your keyboard. 
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Inserting Clip Art 
Included with PowerPoint is a gallery of clip art images that can be 
included in your presentations.  These images are not always of the 
highest quality, but when used selectively they can be a useful part 
of an effective presentation.  To insert a clip art image: 
• In the slide pane of the PowerPoint window, display the slide 

into which you wish to insert an image. 
• Click on the down-facing arrow at the top of the task pane. 
• From the task pane menu, choose Clip Art. 
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• PowerPoint will then display the task pane’s Clip Art view. 
• At the bottom of the Clip Art view, click on the link labeled 

Organize Clips.  
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• Click on the plus sign next to the folder labeled Office 
Collections to show PowerPoint’s clip art collection. 

• Click on the name of any category to view thumbnails of the 
clip art in that category.  The thumbnails will appear in the 
right pane of the Clip Organizer window.   

 

 
 
Tip: If you click on the category name and no images appear in the 
content pane, click on the plus sign next to the folder to view the 
category’s subfolders. 
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• When you find a picture that you wish to insert, place your 
cursor over the image.   

• Click on the down facing arrow that appears at the right of the 
image. 

• From the drop-down menu that appears, click on Copy.   
 

 
 
• Close the Clip Organizer window.   
• When the following window pops up, click Yes 
 

 
 
• From the Edit menu choose Paste and the PowerPoint will 

insert the clip art image in the middle of your slide. 
• Finally, move this image to an appropriate place on your slide. 
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Inserting sounds 
In addition to images, your presentations will often contain sounds, 
movies, and other types of media.  While you may develop your 
own sounds and movies, other sound and movie files can be found 
on the web and utilized (with permission) in your presentations.  
To insert saved sound files: 
• In the slide pane, display the slide into which you wish to insert 

the sound file. 
• From the Insert menu, choose Movies and Sounds, and then 

Sound from File.  
 

     
 
• Use the Insert Sound window to navigate to the folder that 

contains your saved sound file.   
• Click on the sound file you wish to insert, and click OK. 
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• PowerPoint will display a window with the question Do you 
want your sound to play automatically in the slide show? 

 Click on Yes to play the sound immediately when you 
display this slide. 

 Click on No to initiate the sound manually. 
• PowerPoint will insert your sound, represented by a tiny 

loudspeaker icon that you can move anywhere on your slide. 
 

• To play your sound, double click on the speaker icon. 
 

 
Inserting movies 
You can insert movies using a technique similar to the one you use 
when inserting sounds. 
• In the slide pane, display the slide into which you wish to insert 

the image. 
• From the Insert menu, choose Movies and Sounds, and then 

Movie from File. 
 

 
 

• Use the Insert Movie window to navigate to the folder that 
contains your saved sound file.   

• Click on the movie file you wish to insert, and click OK. 
 PowerPoint can play several types of movies, including 

QuickTime and AVI movies. 
• A window will pop and asks you, Do you want your movie to 

play automatically in the slide show? 
 Click Yes to play the movie automatically. 
 Click No to initiate the movie manually  

• PowerPoint will now insert your movie. 
• If you wish, resize or move your movie to another location on 

your slide. 
• To play your movie, doubleclick on the movie. 
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Reorganizing a presentation 
Using the slides tab, you can easily reorganize your presentation.  
To move a slide from one position in your presentation to another: 
• Click on the thumbnail of the slide you wish to move. 
• Drag the slide to its new position in your presentation.   
 

Click on the slide. Drag it to 
 its destination. 

The slide will 
appear in its new 
location. 

 
Tips: Moving slides 
• When you are dragging a slide to a new position, look for the 

horizontal insertion point.  Don’t release the button until the 
horizontal insertion point marks the spot in your presentation 
to which you wish to move your slide. 

• To select and move a several individual slides, hold down the 
control key on your keyboard when you click to select your 
slides.  Once the slides have been selected, drag them to their 
new location. 

 
Tip: Selecting multiple slides from the slide tab 
To select a range of slides in your presentation: 
• In the slide pane click on the thumbnail of the first slide in the 

range you wish to select. 
• Hold down the Shift key and click on the thumbnail of the last 

slide in the range you wish to select. 
• PowerPoint will select the first slide in your range, the last 

slides in your range, and all the slides in between the two. 
To add individual slides to your selection: 
• In the slide pane select a single slide or a range of slides. 
• Hold the Ctrl key and click on the thumbnail of an additional 

slide you wish to select. 
• PowerPoint will add the new slide to your original selection. 
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•  Continue holding the Ctrl key and click on the thumbnail of 
each slide you wish to add to your selection. 

 
Tips: Using cut and paste  
You can also use the cut and paste buttons on the standard toolbar 
to move slides from one position to another in your presentation. 
• Select on the slide or group of slides that you wish to move. 
• On the standard toolbar, click on the Copy button. 
• Click on the slide below which you wish to insert the slides 

you’re moving. 
• On the toolbar, click on the Paste button. 
 
 
 
Presenting your slides 
 
Starting your slide show 
Now that you have finished creating the slides in your 
presentation, you are ready to view the entire show in sequence.  
To view your presentation from the beginning: 
• From the Slide Show menu choose View Show. 
 

        
 
Tip: To begin a slide show from a slide other then the first slide in 

your presentation: 
• At the bottom left of the PowerPoint window, click on the Slide 

Show button to display the current slide in full-screen view. 
       

 
 
Tip: Before presenting your slide show, it may be a good idea to 
view your show in a classroom to make sure that your text and 
graphics are visible from all parts of the room. 
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Navigating within your slide show 
While you are presenting your slides during a lecture or 
presentation, you will often want to either move forward and 
backward within your presentation, or display a specific slide.  
PowerPoint’s Presentation toolbar can help you navigate within 
your presentation. 
 
• Locate the Presentation toolbar in the bottom left corner of 

the slide. 
 

 
 

• To move to the next slide, click on the right facing arrow. 
  

       
 
• To return to the previous slide, click on the left facing arrow. 
 

 
 
• To navigate to a slide that is not immediately before or after the 

current slide: 
o Click on the presentation menu button. 
o From the Go to Slide submenu, click on the name of 

the slide you wish to display. 
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• To end your slide show: 
o Click on the presentation menu button. 
o Click on End Show. 

 
 

Tip: You can also use the following keyboard buttons to navigate 
during your slide show presentation. 
 
If you want to … Press the … 

Display the next slide 

→ (right-facing arrow) key 
↓ (down facing arrow) key 
Enter key 
Space bar key 

Display the previous slide ← (left-facing arrow) key 
↑ (up-facing arrow) key  

Return to the normal view Escape button 

Blank the screen B key 

Make the screen white W key 

End your slide show Esc key 

 
 
Making screen annotation during your slide show 
During your slide presentation, you may find it useful to 
emphasize some of the content on your slide without turning away 
from your audience to face the classroom screen.  PowerPoint’s 
Ink annotations tool allows you to do this with your mouse, much 
like using a dry erase marker on an overhead projector 
transparency.  To use this tool: 
• Locate the Presentation toolbar at the bottom left corner of 

the current slide. 
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• Click on the ink annotation tool button. 
 

 
 
• From the drop-down menu that appears, click on the type of 

pen you wish to use while annotating your slide.   
  

If you want to… Click on… 

Draw a thin line  
Draw a thick line  
Highlight without 
covering the element  

  
• Once you have chosen your drawing tool, place your cursor on 

the part of the slide that you would like to emphasize. 
• Click and drag the cursor to underline, circle, or highlight the 

element on the slide. 
• To return to the arrow when you have finished with your 

annotations, click on the ink annotation tool button and click 
on Arrow. 
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• PowerPoint will allow you to save any annotations that you 
have made during your presentation.  To do so: 

o Click on the button labeled Keep from the window that 
appears when you end your slide show. 

 

 
 

o If do not wish to save these annotations, click on the 
button labeled Discard. 

 
Tip:  You may want to change the color of your annotations, 
particularly if the default ink color blends into the background of 
your slide.  To change the pen’s color:  
• Click on the annotation tool.   
• From the annotation tool’s drop-down menu, select the Ink 

color submenu. 
 

 
 

• From the color palette that appears, click on the square 
containing the color you want to use for your slide annotations. 
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